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1 – Introduction

Release 1.1.24 is the latest Stable release of EigenD. It contains a large number of bug fixes 
from the last stable release (1.0.14) as well as many significant changes to existing 
behaviour, all of which is detailed below. It is the end of the line of the 1.1 development 
releases.

This release will upgrade previous setups from earlier stable and testing releases.

2 – Bugs fixed in this release

A large number of bugs have been fixed since the 1.0.14 release. Therefore we have just 
included the issues still known with this release – in all other cases we believe the bug to be 
fixed.

• 1.1.24:

Fix a problem where the setup of the Browser can get lost.
Fix problems with polyphonic aftertouch in AU's.

3 – Bugs and known issues in this release

• Switching from Factory Tau to Factory Pico setup occasionally freezes
• EigenD gain structure needs revisiting
• Pico controllers not bound to active instrument when using AU
• Unable to select which channels to use for multichannel audio interface in Browser
• Audio output not saved in user setups
• Playing a recording after the first take sometimes glitches
• Pitch bend oddity when set to 72 semitones



4 – Changes and Improvements

Changes since 1.0 release series

The 1.1 release series introduces some new features and improvements to the 1.0 stable 
series:

• New EigenD User Interface

There have been a number of improvements to the EigenD user interface since the 
1.0 release series.

The EigenD drop down menu found in the 1.0 release series has been replaced by a 
graphical window for loading your EigenD setups:

To load an EigenD setup, select the desired setup from the setup tree and click 'Load'. 
A separate progress window will appear temporarily while the setup loads. Once it 
reaches 100% it will disappear and EigenD is ready.

If you would like that setup to load automatically the next time you start EigenD, 
click the 'Default Setup' option on the right hand side of the Load window (above).



To open the EigenBrowser and EigenCommander applications, you now need to 
select 'Run EigenBrowser/EigenCommander' from the EigenD 'Tools' menu.

Each of the currently running Audio Unit/VST windows can be accessed through the 
'Window' menu, as well as the 'System Usage Meter' and the 'Load Window'. Loading 
and Saving Setups, Reporting a Bug and finding out 'About eigenD' are all located 
under the 'File' menu.

To upgrade your User Setups from previous versions of EigenD to include new fixes 
and improvements, there are two methods. You can either select then from the 'User 
Setup' subheading (you will see in the Setup Description which versions they have 
been upgraded from) and click Load, or select a setup from the 'Previous Versions' 
subheading (these setups are not upgraded automatically) and click the 'Upgrade 
Setup' option shown in the above diagram. 

You can also now Edit the name and Delete your User Setups using the 'Edit' and 
'Delete' buttons (shown above).

Saving Setups
In the revamp of the EigenD user interface, you can now configure the name for your 
EigenD user setups.

To display the Save dialogue, select 'Save' from the File menu or press 'cmd-S':



To save a User setup, you have a number of options. In order to allow the loading and 
saving of User Setups using the Belcanto language, only names which have 
associated Belcanto words can be used for EigenD setups. Therefore you can add 
tags and descriptions to help describe each of your user setups. The 'short tag' is 
contained within the filename and will be displayed in parentheses in the Load 
window next to the setup name.

The longer description will appear in the 'Setup Description' box shown in the Load 
window diagram above.

To save a new user setup in the form 'User X', click on the 'New' button in the 'User 
Setup number' field in the diagram above. This will generate a new User Setup 
number.

If you would like to save a new user setup with a unique Belcanto name (using words 
or 'notes'), type your desired name into the 'Belcanto Name as Words/Notes' field 
above. Please be aware that this will only accept valid Belcanto words.

If you would like to save over an old user setup of the form 'user X', select your 
desired setup name from the drop down menu in the 'User Setup Number' field 
above. If you would like to save over and old user setup with a Belcanto name, select 
the desired setup name from the drop down menu in the 'Belcanto Name as 
Words/Notes' field. Once ready, click 'Save' – a dialogue box confirming the success 
of the saving process will appear once complete. If you need more information, click 
on the 'About Setups' button  in the 'Save Setup' dialogue above.

• New AU/VST host

Since the 1.0 series we have significantly changed the Audio Unit host which will 
now also host VSTs, and support Cocoa Audio Units.

Changes to existing AU/VST scanning behaviour

We have made some significant changes to the Audio Unit/VST validation process:

• The scan now takes place out of process so it cannot crash EigenD itself.
• The scanning is done during installation, and also at startup time if no 

~/Library/Eigenlabs/Plugins/plugins_cache exists.
• The plug-in scanner can now also be started manually from the 'Tools' menu.

The scan dialog allows you to perform a full scan, which rescans everything, or a 
quick scan, which will skip any plug-ins that are in the current 'plugins_cache' or 
'bad_plugins' lists.  When doing a quick scan you can choose to rescan 'bad plug-ins' 
by selecting them in the table.

Each plug-in to be scanned is opened in a separate process.  If it does not open within 
10 seconds, or if it crashes, it will be marked as a 'bad plugin'.  (Note that if a plug-in 
chooses to put up a modal dialogue during initialisation, the dialogue will have to be 
dismissed before the 10 second timeout, otherwise the plugin will be marked as bad).



When the scan is complete, a dialogue appears showing the list of 'bad plugins'.

The Audio Unit parameter routing window has also been changed. To display the 
Audio Unit parameter window, click on the 'Configure' button on the top left hand 
corner of your AU Window.

This will now display the new window:

The principal of control over the parameters is the same: you have a table with the 
EigenD Audio Unit parameter numbers in the row at the top, and the plug-in's 
input parameters in a column on the left hand side.

Instead of a 'tick box' mechanism to toggle control on and off as in the previous 
version, you now have a higher degree of control over the way that EigenD uses the 
plug-in's parameter information. You will see in the diagram above contains three 
numbers '1.0' for parameters 1, 2 and 5. This number tells EigenD to route the 
EigenD controller to the desired plug-in parameter, and to scale it by the specified 
number – in this case 1. This gives you more options for your expression information 
– e.g. if you set the number within the box to a negative number, you will invert 
your control signal.

You can turn on parameter routing by clicking within the desired cell – the value can 
then be adjusted. Drag your mouse cursor up to make a fine positive adjustment, 
down for a fine negative adjustment, left for a coarse negative adjustment and right 
for a coarse positive adjustment. A single click within a cell turns off routing for that 
particular parameter. Other than that described above, you should see no other 
differences from the old Audio Unit host. 



• Improved cello model. The following changes have been made to the cello model in 
order to improve its sound and playability:

1. Monophonic note transitions: When playing in mono mode, the previous cello 
model would transition between a note being held and a new note by sliding 
between the two pitches. This modelled sliding the finger on the string for every 
note transition. To improve playability, this has been replaced with a model of 
stopping the string with a finger at the new note position giving a smooth but 
rapid note transition.

2. Strip control bowing speed: the finger movement speed needed to attain a note 
from bowing has been reduced so that a longer stroke can be achieved for legato 
style bowing.

3. Improved sound and playability from the addition of multiple string models: 
models of individual strings are now included so that note pitches are matched to 
models of the strings that normally produce those notes on a cello. This improves 
the harmonics of the notes and hence the bowing sound produced. It also allows 
Helmholtz oscillations to be achieved more readily so that a smooth note tone is 
easier to achieve over a wider range. This improves playability by reducing non-
Helmholtz artefacts such as 'double slipping', which could lead to an unpleasant 
second harmonic dominating the sound in the previous model.

4. String decay when the string is released by the bow: when holding the keys and 
releasing the strip controller after a stroke, the release of the bow from the string 
is now simulated giving a more natural sounding string decay. The string is 
damped when a key is released. This can also be achieved when stopping blowing 
when bowing with the breath controller. Note: the effect is less prominent with 
the breath controller as it has a physically softer release response.

5. Body response sound: the balance of the string and body response sound has been 
improved. The long cello body impulse response has also been filtered of 
recording noise which previously gave an unnatural ringing in the response tail.

6. Noisy artefacts in the attack of the notes have been reduced, particularly in the 
lower octaves.

• Scripting support.

There is now a script browser, which allows the user to select and execute both 
factory and user defined script files, which may have an arbitrary effect on the 
system.

In the pico setups, there is a new key 12 in the instrument and FX control mode 
which places the browser in script mode.

In Alpha Setups 1, 2 and 3, there is a new key 1 in the 'Pedal Calibration' Advanced 
control mode (please refer to page 13 of the Alpha Quick Reference Guide for more 
details.

To run a script, select the script with the scroll keys or mouse.  A description will
be displayed.  Select the script again to run it.

Some scripts have been supplied which remap the keyboard in various ways, and 
which change the pitch bend range to various values.



• Transposition up/down

You can now change the interval that the octave up/down keys on the Pico transpose 
by, using the new scripting mechanism.

Bring up the script browser in the EigenBrowser by pressing key 16 in the 
Instrument/FX Control mode, and navigate to the 'Octave key transposition' folder.

You will now see a list of scripts, labelled from 'minor 2nd' (one semitone) through to 
'Two Octaves', executable via the above method, which will then allow you to adjust 
the interval by which the 'octave keys' transpose by.

Please note: the tonic of your scale will not change when you use this functionality – 
you will have to reset your octave keys (using the 'reset' script) for this to return to 
normal. 

• MIDI input

We have introduced a MIDI input since the 1.0 release series. So far this has only had 
limited testing, and is still a work in progress. This introduces the following features:

MIDI input configuration within factory setups

If you have external hardware MIDI devices (such as a MIDI pedal board), you can 
now use this to control various aspects of the EigenD software. 

In Pico Factory Setup 1, within the Instrument/FX control mode, there a new 
control – below the MIDI output port browse key there is now a MIDI input port 
browse key, which will display a list of MIDI devices as per the MIDI output port 
browse view.

In the Alpha Factory Setups, within the Advanced MIDI Out 1 control mode there 
is a new MIDI input browse key, which will display a list of MIDI devices as per
the MIDI output port browse view. This is located on the key to the right of the MIDI 
output port browse key. 

Once you have selected the desired device from the Browser,you will need to 
configure your hardware MIDI device to produce MIDI note number information.
The following table describes the list of actions that are triggered by corresponding 
MIDI note numbers:

Action 
Load setup 'user 1'
Load setup 'user 2'
Load setup 'user 3'
Load setup 'user 4'
Load setup 'user 5'
Load setup 'user 6'
Load setup 'user 7'
Load setup 'user 8'

MIDI note no.
12
13
14
15
16
17
18
19



Action
Load setup 'user 9'

Load setup 'user 10'

Metronome start/stop

Set tonic to C
Set tonic to C#
Set tonic to D 

Set tonic to D# 
Set tonic to E
Set tonic to F 

Set tonic to F# 
Set tonic to G 

Set tonic to G# 
Set tonic to A 

Set tonic to A# 
Set tonic to B

Set scale to major
Set scale to harmonic minor
Set scale to melodic minor 

Set scale to chromatic 
Set scale to blues 

Set scale to pentatonic major
Set scale to diminished 
Set scale to whole tone

MIDI Note no.
20
21

59

60
61
62
63
64
65
66
67
68
69
70
71

72
73
74
75
76
77
78
79

In both the Pico and all the Alpha Factory Setups, the actions referred to by the above 
table apply to ALL the keygroups (i.e. normal behaviour for Factory Pico 1 and 
Factory Alpha 1, and acts in the same way as the Global Scale and Tonic controls in 
Factory Alpha 2 & 3 - please refer to page 11 of your Alpha Quick Reference Guide 
for more information.)

You can change the scale that is set by the MIDI note number in the same way that 
you change the scale for the Scale Controls in the Pico and Alpha Factory Setups 
(please consult the relevant pages of your Quick Reference Guide for more 
information).



• MIDI clock sync

The EigenD metronome can be synced to an input MIDI clock allowing other MIDI 
applications and devices to control the playback and tempo of EigenD.

To sync the metronome to a MIDI clock, the MIDI input port must first be set to the 
port that the MIDI clock source is using. See 'MIDI input configuration within 
factory setups' above. Note: if using the IAC Driver on both the input and output 
MIDI ports to connect EigenD to other applications, then currently the input and 
output ports must use different IAC buses.

To activate MIDI clock sync, first ensure the metronome is stopped. In Pico Factory 
1 setup, the key to activate MIDI sync is now included below the MIDI input port 
browse key in the MIDI control kgroup of the Instrument/FX control mode. In Alpha 
Factory setups, the activation key is located in Advanced MIDI Out 1 control mode 
on the key below the MIDI input port browse key.

After activating MIDI clock sync, the metronome must be started in the normal way 
to arm the metronome to respond to clock sync. As soon as the metronome receives a 
clock sync signal then EigenD will begin playback. When the clock source stops 
playback, then EigenD will also stop. The MIDI clock sync state can be viewed by 
browsing the metronome.

Stopping the metronome will cause EigenD to stop independently of the clock 
source. If the metronome is stopped then restarted whilst a clock source is running, 
then the MIDI clock sync is rearmed and will start when the clock source next issues 
a start signal. Deactivating MIDI clock sync whilst the metronome is running will 
cause the metronome to continue free running at the last tempo determined by the 
clock source. If the MIDI clock sync is then reactivated, it will be rearmed and will 
start when the clock source next issues a start signal.

The MIDI clock sync can compensate for the delay that arises in sending the MIDI 
clock signals through system. This can be used to ensure that the metronome is 
tightly in sync with the clock source in terms of the average system delay. Note that 
small amounts of system delay variation may exist in the MIDI clock signal around 
the average delay. 

The current delay compensation setting in milliseconds is shown as the 'MIDI clock 
latency' when browsing the metronome. This can be adjusted in the Pico Factory 1 
setup using the key below the MIDI clock sync activation key. In the Alpha Factory 
setups,  it can be adjusted with the key located in Advanced MIDI Out 1 control 
mode below the MIDI clock sync activation key.

• MIDI virtual source and destination

MIDI inputs and outputs now create virtual MIDI endpoints visible to other MIDI 
software running at the same time as EigenD. These virtual endpoints are created in 
addition to the ports than can be routed to the sources and destinations listed when 



browsing the EigenD MIDI ports. A destination will be created for each MIDI 
input/output port, named 'Eigenlabs 1, Eigenlabs 2' etc. 

The Factory Pico Setup has one MIDI input and one MIDI output, and the Factory 
Alpha Setups have one MIDI input and two MIDI outputs. These can be used to 
route MIDI into and out of EigenD directly by selecting these from the list of 
available endpoints in other MIDI software running at the same time as EigenD. 
Note: the EigenD endpoints do not appear when browsing the MIDI ports using 
EigenD as it is invalid to connect EigenD directly to itself. 

• Belcanto Interpreter input keygroup

In EigenD 1.1. series, scripts have been included which connect the Eigenharp 
keyboard to the Belcanto Interpreter in all the Factory Setups. There are two factory 
scripts – one for Pico Setup 1 and one for the Alpha Setups. Once the script has run 
(see above instructions for more details), the Interpreter will be found where the 
Scheduler Control mode was previously connected in Factory Pico Setup 1, and in 
the Alpha setups there is a new mode situated in the top left hand corner of the 
keyboard (underneath the breath pipe) when you press the main mode key. 

When you input Belcanto, your Belcanto 'notes' will appear in a new section of the 
Commander called the 'staff view' (a five line musical staff). Where you would 
normally play the first eight notes of the scale on both the Pico and the Alpha, you 
will find the first eight Belcanto notes appear in the staff view underneath (numbered 
1 to 8).  You will also notice that under each Belcanto word in the Commander's 
dictionary view, there is a corresponding sequence of notes. To type a Belcanto word,
you need to press the keys that correspond to the note sequence shown in the 
dictionary, but play a 'louder note' (i.e. tap the key harder) to terminate the word 
(this lets the Belcanto interpreter know that you have finished a word).

Further documentation about EigenD Agents and Belcanto can be found at our 
documentation wiki (http://www.eigenlabs.com/wiki/)



Changes and improvements in the 1.1 series:

Keyboard axis window parameters

The EigenD Keyboard Agents have two new nouns:

131 8832 8833
   roll        axis        window

and

131 8832 8833
  yaw        axis         window

The new 'axis window' is used to control how much of the movement of the Eigenharp keys is used 
for the roll and yaw signals. The axis window parameter is set as a value between 0 and 1 using the 
following Belcanto commands:

 117  11 5 63 8833 23 11 67
keyboard   1    hey  all    window      to       1      set

 117  11 5 63 8833 23 22 33 18  67
keyboard   1    hey  roll    window     to      0        .        8       set 

 117  11 5 63 8833 23 22 67
keyboard   1    hey  roll    window     to      0       set 

For example, if you set the axis to 0.5, then only half of the keys total movement is used, and the 
outer half is ignored. This has the effect of getting all the roll/yaw range without having to move the 
key as far.

MIDI rate throttling

Due to the high data rate produced by the Eigenharp, we have added the ability to throttle 
the EigenD MIDI output data rate for use with external hardware MIDI devices via Belcanto 
scripts. 

There are scripts provided to throttle and 'un throttle' MIDI output 1 and 2 – the script for 
MIDI output 1 can be used with all the Factory Setups (Alpha, Pico and Tau) and the script 
for MIDI output 2 is for use with the Alpha and Tau Setups only. 

The script which throttles the MIDI output applies a one message per ten millisecond rate 
limit to the specified MIDI output instrument – this should throttle the output sufficiently for 
use with a standard MIDI cable.

The scripts will be available under 'Factory Scripts �  MIDI Output'. 

The MIDI rate throttling has also been removed from the Audio Unit/VST instrument host.


